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Sign In

To access Business Suite, Business Essentials and other services (refer to_title page for
complete list), go to cnb.com, click the Sign In button on the upper right.

@ AboutUs [] ContactUs © Locations

CiTy NATIONAL BANK

% Personal Business & Commercial Private Banking Insights Industries We Serve
I8 AN RC comPANY

IT PAYS TO BE
PREFERRED.

Preferred Banking clients receive exclusive access to
complimentary wealth planning services, discounted
mortgage rates' and more.

LEARN MORE

Call us at (800) 773-7100 FIND A LOCATION

At the sign-in screen, enter your User ID and Password set up for you by your Company
Administrator, and then click Sign In, as shown below.
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SIGNINTO

ACCESS POPULAR
‘ONLINE SERVICES

City National Online
Business Suite™
Treasury Net
Business Online
Business Essentials
E-Deposit
Wholesale Lockbox

ALL ONLINE SERVICES

Account Service Manager
ACH Positive Pay

ARP Reports

Book2Bank

Brokerage

City National Card Alerts
City National Rewards

City National Visa Gift Card
CityTax

Commercial AP
‘Commercial Card Online
Commercial Prepaid Cards

Controlled Disbursement

Account Setup

CITY NATIONAL BANK

Bl AN RBC COMPANY

Need Help? Personal Banking (800) 887-1290 | Business Banking (800) 599-0020

City National Online

User ID

Password

l:l Remember my User ID

Forgot User ID?
Forgot Password?

NEW TO PERSONAL ONLINE BANKING?

ENROLL NOW

When signing on to the service for the first time, you will be guided through Account
Setup and Personal Information and Security Setup, which will assist you with verifying

and configuring your profile.

Account Setup

Create Password

Confirm Identity Verification

Create a password

Enter your new City National Online password below. Be sure to follow the password requirements to ensure your password is secure,

Password

Confirm Password

Continue Cancel

Password guidelines:

® At least 8 characters (required)

*® Uppercase letter (required)

* Lowercase letter (required)

* Number (required)

® Special characters (required) only include the following: , 1@ #$ % " & ¥ () _+=-
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Create Password

You will be required to create a new password during your initial logon to the system.
The guidelines for your new password are shown on the Create Password page. As you
create your new password, the guidelines will be displayed in green to confirm that your
password matches the criteria; otherwise, they will be displayed in red.

Account Setup

Create Password Confirm Identity > Verification

Create a password
Enter your new City National Online password below. Be sure to follow the password requirements to ensure your password is secure.

Password Password guidelines:

« At least 8 characters (required)

Please enter 3 password using the guidelines listed. « Uppercase letter (required)
¥ Lowercase letter (required)
Confirm Password X Number (required)

¥ Spedial characters (required) only include the following: . ! @ # 3% ~&* () _+=-

Continue Cancel
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Confirm Identity

Account Setup

Create Password Confirm Identity Verification

Confirm Identity

To confirm your identity and protect your account information, we'll send you a one-

time verification code by email, text®, or voice message. What you should know

Select how you would like to confirm your identity: In order to protect your account information, we require you to

Email confirm your identity before accessing City National Online.

mai

® amErErErRs@cnb.com The contact information displayed on this page is the most
current email address and phone number on file; please choose

D amFFEEEEE3@gmail.com one of the verification methods shown to confirm your identity.

oh Note: For your security, portions of your contact information

R one R are masked, and displayed as "***".

O Text O Voice Message ***-##¥.3943

If you don't receive your verification code, please select an
alternate verification method. If you cannot complete this
Cancel process, or the contact information shown is incorrect, please
contact your Relationship Manager. You may also call the phone

number on the back of your check card or statement for further

assistance
* Message and data rates may apply.

Verification

The third step in the Account Setup workflow will prompt you to confirm a verification
code sent to your email address or phone. Upon receipt of the code, enter the code
provided in the Verification Code field and click Verify to complete the verification
process. If the email was not received in your inbox, you can ask to have the verification
code resent by clicking the Select a different verification method link.

Account Setup

Verification Code

A verification code has been sent to:

. .
#HE AEE 3043 Why register your device?

. N . . When you register your device, City National Bank will
Please enter the verification code to confirm your identity. . ) 3
automatically recognize it as a device that is authorized to
access your account information. You'll be able to sign in quickly
Verification Code without needing to confirm your identity.

300653 You can register more than one device, but it is not

recommended to register public computers or devices,
Register your device (optional)

cancel

Didn't receive a verification code yet? Sometimes it can take a few minutes.
Select a different verification method.
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E-Consent
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Profile Setup

E-consen! Terms & Conditions ) Personal Information ) Security Questions

You must view and accept the e-consent in order to continue.

Consent to Use of Electronic Communications and Electronic Signatures

In connection with our relationship with you, we are required by law to give you certain information “in writing” - which means you are
entitled to receive it on paper. We need your consent in order to provide you this information electronically instead. We also need your
general consent to use electronic records and signatures in our relationship with you. Please read the information below carefully and
thoroughly before you consent.

In this Consent, the words “we,” “us,” and “our” means City National Bank. The words "you" and “your” means the person giving consent.
“Online Service” means each and every service we offer that you apply for, enroll in, agree to, use, administer or access using the Internet, a
website, email, messaging services (including text messaging) and/or software applications (including applications for mobile or hand-held
devices), either now or in the future. “Communications” means each disclosure, notice, agreement, undertaking, fee schedule, statement,
record, document or other information we provide to you or that you sign or submit or agree to at our request. “CNB Product” means each
account, product or service (including each Online Service) we offer that you own, apply for, enroll in, agree to, use, administer or access,
either now or in the future.

Your consent

Your consent applies to all Communications between you and us in connection with a CNB Product. We may also use electronic signatures i

O1 have read and agree to the terms of Consent to Use of Electronic Communications and Electronic Signatures.

- oy
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Terms & Conditions

CiTv NATIONAL BANK H
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Profile Setup

E-consent Terms & Conditions Personal Information Security Questions

You must view and accept the terms & conditions in order to continue.

Welcome to the City National Treasury Management service (“Service”). In order to access and use the Service, you must first agree to these
terms and conditions of use of the Service as described below (“Agreement”). If you do not accept the terms of this Agreement, you will not be
able to access or use the Service.
Your use of the Service is subject to the terms and conditions described in any deposit, loan, credit, investment, brokerage, or other
agreements between you and us. These agreements include but are not limited to the following, as applicable:

e Treasury Management Services Disclosure and Agreement
Account Agreement and Disclosures

e Consumer Electronic Fund Transfer Agreement and Disclosure
o Business Electronic Fund Transfer Agreement and Disclosure
o Fee Schedule: Personal Products & Services

Fee Schedule: Business Products & Services

Terms & Conditions for uae%(»ly National websites

This Agreement is also subject to all state and federal laws, rules and regulations, as applicable, of any funds transfer system or payment

svstem used in connection with the Service. When vots access an acconnt or initiate a transaction throueh the Service. the asreements voui %

®1 have read and agree to the Terms and Conditions.

| Accept Cancel

Personal Information

The next step in the first-time account setup process allows you to update your time
zone and add Email addresses and/or Phone Numbers so they are available later for
sending a verification code. You do not have to update this page, but if you do, click
Save Changes to move forward with the process.

e To update the Time Zone, select the appropriate time zone from the drop-down
menu.

e To add additional phone numbers or emails, click Add Phone Number or Add Email
Address and fill out details.

e Toremove an added phone number or email, click the Remove link.
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Profile Setup

E-consent ) Terms & Conditions Personal Information Security Questions

Review your personal information below. If your information is correct proceed to the next step. If not select the information that you would like to
edit.

Email Addresses
alexa@cnb.com Primary

Add Email Address.

Phaone Numbers

United States (+1) 330-608-6298 Work 1 Primary

Add Phone Number,

Thhe Zone

US/Arizona, US Mountain Standard Time

Change Time Zone

“ — SSEE

Security Questions

Security questions are challenge questions you set up that may be used to verify your
identity when you call in for support from a live support representative.
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E-consent Terms & Conditions ) Personal Information Security Questions

Update your security questions every so often to prevent security issues.

Security Question #1 Security Answer Requirements

What is the last four digits of your social security number? v Minimum 3 characters

- Maximum 50 characters

Answer
- Alphanumeric, ', -, and spaces are allowed

Must be unique
Security Question #2
What is your favorite sport? v

Answer

Security Question #3

In what city was your father born? ¥

Answer

S

Sign-In Assistance

If you forgot your user ID or password, you can click the Forgot User ID? or Forgot
Password? support links on the Sign In page. You will be asked to provide information
to receive assistance with retrieving your user ID or with getting a new temporary
password.

You can also contact your company’s Administrator to assist you with resetting your
password.
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SIGNINTO City National Online

User ID

City National Online

Business Suite™

Business Essentials Password

Remember my User ID

\ Forgot User ID?

Forgot Password?

Dashboard & Widgets

The dashboard is the first screen you see after signing in to the portal. It gives you the
ability to personalize your banking experience by accessing widgets. Widgets are
module features that allow you to perform a variety of common tasks such as quickly
making a payment, transferring funds, stopping payment on a check, taking action on
tasks, and making positive pay decisions.

Note: This feature applies to the Business Suite and Business Essentials services. It
does not apply to E-Deposit, Account Reconcilement Processing, Account Services
Manager (ASM) or other services linked to the Business Suite service.
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Helpful Shortcuts

Add Widget w
Add Widget

Account Summa
Account Summary - S
Aleris Center
Groups Reporting Transaction Search ) )
Audit Information
Check Issue Management
Rg
Checks and Stops Inquiry
~ Deposit Accounts Confidential Settings
1263
Deposit Tickets and ltems
Exceptions Management
Exports
Filter | Select fields h | File Import History
Impaort Map
Account Name | Account Number Ledger Available Net fct|
o Motifications
ACME Checking with Sweep 100010001 146,865.00 -3,236,045.80
ACME Medical Child 1 0.00 0.00 Payee Center
ACME Medical Child 2 0.00 -454,358.31 Payments
¥
Quick Transfer
\fiewing 1-3 of 8 records Displa',’| 3 |
Recuming Payment Exceptions
Rename Bank Account

~ Loan Accounts

Managing Dashboard Widgets

Reporting

Statements

You can add widgets to your dashboard page and move existing widgets to different
locations on the page. You can also resize existing widgets and remove those you do not

want to use anymore.

Add a widget:

1. On your dashboard page, click the Add Widgets drop-down.

2. Select the desired widget from the list.

The newly added widget appears at the bottom of the page.
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Resize a widget:
1. Click the Settings icon in the upper right-hand corner of the widget.

2. Click Resize. The widget is resized so that it takes up only half the width of the
screen.

3. Toreturn the widget to its original size, repeat steps 1 and 2.

Note: Some widgets with more information may not present well at half-size, such as
Account Summary or the Payments List.

Move a widget:

1. Left-click the widget and, with the mouse button depressed, drag and drop the widget
above, below, or next to another widget on the dashboard.

Remove a widget:
1. Click the Settings icon in the upper right-hand corner of the widget.
2. Click Remove.

The widget is deleted from the screen. Removed widgets can be added again as
desired.

Get help with a widget:

Many widgets provide a help option.

1. Click the Settings icon in the upper right-hand corner of the widget.

2. Click Help to see the appropriate help topic for the widget.
Customizing Your List View:

Many modules and features in the portal are organized in a list view. List views can be
updated and modified in a variety of ways to personalize your information and banking
experience.
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Dashboard

Add Widget ~

Account Summary

m Groups I Reporting I Transaction Search

3 Refresh Balances  02/04/2021 09:52 AM

~ Deposit Accounts Ledger

Available

126,340,003.22  131,211,463.08

L= I
Filter | Select fields - | Set As Default My View
Account Name | Account Number Ledger Available Net Activity Today I -n_ I
AGME Checking with Swesp 100010001 146,968.00 3,236,046 80 -3,383,012.80
ACME Medical Child 1 0.00 0.00 0.00
ACME Medical Child 2 0.00 -454,358.31 -454,358.31
»
Viewing 1-3 of & recards. Dispay| 3~ Jomrpase ¢ Pagel 1~ |ora

Available Actions:

The Account Number column allows you to take action on a single item in a list.
Depending on the item, you can view, modify, approve, or delete an item.

Click the drop-down menu to view available actions. If only one action is available for an
item, access that function by clicking it.

Navigating Through a List:

The total number of records and number of pages in a list is shown on the bottom of the
list view.

Viewing 1-10 of 302 records Display per page Page of 31 )

Click the arrows or the Page drop-down to navigate from one page to the next.
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Viewing 1-100 of 302 recor ds Display | 100 ~ |per page Page

Bow N oA | =

Use the Display drop-down to select the number of records you want to appear on each
page.

Viewing 1-10 of 302 records Display| 10 ~ |per page Page| 1 - |of31 »

3

5
10
25
50
100
250

Selecting a Predefined View:

Many lists have several predefined views beyond the default view. These pre-defined
views display records that meet specific criteria. For example, Payments widget has the
predefined view Payments Requiring Approval, which shows all payments that still need
to be approved. A user who primarily approves payments may want to make this their
default view.

To use a predefined view:

1. Use the View drop-down located on the right side of the screen to select the view.
The drop-down lists the available predefined list views for this screen.

2. Select the desired view in the list.

The displayed list view will change to the one you selected.

To set a new view as default:

1. Use the View drop-down to select the different view from the list.

2. Click Set As Default.

The selected list view will be the default each time you return to this list.
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Filtering a List:

You can use the Filter drop-down to limit the records shown in a list of records that meet
specific criteria.

Lists can be searched using the quick search or the Manage Filters option. For simple
searches, use the quick search. For more complex searches, select Manage Filters.

To filter the list with the quick search:

1. Inthe Select Fields drop-down, select the field you would like to search by.
2. If necessary, select an operator from the list.

3. Enter the search criteria.

4. Click Apply.

The records that meet the criteria you specified appear in the list view.

5. If you wish to search the entire list again, click Clear All and enter a new search.
To filter a list using the Manage Filters option:

1. Inthe Select fields drop-down, select Manage Filters.

The Manage Filters window displays.

2. Mark the boxes to select the fields to use as search criteria.

If necessary, select an operator such as is equal to or is greater than. If the field
requires a date selection, use the calendar pop-up to select a date.

3. Enter the search criteria.

4. Repeat steps 2 and 3 until you have selected as many filters as desired.
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Manage Filters »®

2 of 31 filters selected

W1 Account Name ACME FILMS
W1 Account Number 001 KHAEX -
{"iBank Code

[[] As-of Date/Time
Ocey

[JLedger

Apply Clear Al

If you need to remove filters, uncheck the boxes to remove them.

5. When you have finished, click Apply to see the search results. The records that meet
the criteria you specified will appear in the list view. If you use the advanced filter
again, the system will search all of the items in the original list (not the filtered list).

6. Click Clear to remove the filter.

Sorting a List:

A list can be sorted so that the order of the rows is reversed.
To sort a list:

1. Click on the column header. The rows of data will be resorted. A blue down arrow
appears in the column to indicate the sort order.

2. Toreturn the rows to their original order, click the column header again.

Moving Columns:
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You can move columns to a new position on a list.
To move a column:

e Drag and drop the column to the new position.
Adding or Removing Columns:

Columns can be added or removed from some lists in the application. If the list supports
this function, you will see the arrow icon in the header row at the right side of the list.

To add or remove columns:

1. Click the tool icon in the upper right corner of the List View. The available columns
are displayed. The checked boxes indicate which columns currently appear in the list
view.

2. Check or uncheck the columns you would like to include/exclude in your list, and then
click Update.

Refreshing a List:

A number of lists feature a Refresh icon in the upper-right corner. Along with the icon is
a notification of the most recent date and time.

When you click the icon, the list is refreshed and the date and time are updated. This will
be especially useful if you are working in a list for an extended period.

Saving a List View:

Once you have arranged a list view with the proper columns, sort order and filters, you
can save the list for future use.

To save a view:
1. Click the View drop-down in the top right corner of the list.

2. Select Save View.

January 2022 — City National Online General Overview




CITY NATIONAL BANK

Bl AN RBC COMPANY

Deposit Accounts - CHNE USD &

Lo

| Deposit Accounts - CNB USD

Foreign Currency CD Summary-Prior Day

Foreign Currency Demand Summary-Prior Day

hMulti-Bank Accounts

3. Inthe Save List window, enter a name for the list and click Go.

I Export & Print

Deposit Accounts - CNB USD »

e

Deposit Accounts - CNB USD

Foreign Currency CD Summary-Prior Day

You can now access the list view from the View drop-down every time you visit the list.
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Assigning the Default View:
The default view will be automatically selected every time you open a list.
To assign the default view:

1. Select the view you want to set as the default from the View menu.

2. Click Set as Default.

I Export & Print

Set As Default MY View -

Removing a Custom List view:

You can remove list views that you have added; however, you cannot remove a default
or pre-defined list view.

1. Toremove a view that you have added, select the View menu, and click the
trashcan icon next to the custom view.
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